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Program Overview

Quick and easy image editing promises you the multi-talented Picmaster.
Functions range from simple scanning, using filters, putting images into catalogs to huge-poster-prints, 
video image capturing, webcams, slide show presenting and 3D Anaglyph pictures.
Thousands of photoshop filter plugins from the Internet can be included in Picmaster.
You can record sound comments to the pictures which gives your real multimedia feelings combined with
the slide show.
Create real 3D-Images which you can see with mirrors or red-green glasses. Print out your own glasses 
with Picmaster.
An image browser in Explorer-style shows you all images as a preview where you can set different 
sorting options. 
The webcam images can be uploaded into the Internet via FTP, HTTP or Email. The system also reacts on
movements so it turns into an alarm system.
All commands can also be entered, saved and played at a command prompt so that repeated operations 
can be automated.
And with the possibility of previewing all operations Picmaster becomes a very comfortable program for 
you.
Why not take the Picmaster-Info-Tour at http://www.graphics-tools.com/tour/tour.html and read all about 
the details of the program with screenshots.

Download Addresses:
    http://picmaster.virtualave.net/english/picmaster.exe
    http://home.t-online.de/~alexander.sabov/english/picmaster.exe
    http://picmaster.jumpcomputers.com/english/picmaster.exe
    http://www.redrival.com/picmaster/english/picmaster.exe

Program Info:    
    http://www.graphics-tools.com

Picmaster Info Tour:
    http://www.graphics-tools.com/tour/tour.html

Homepage:
    http://www.graphics-tools.com



History

V2.21 1.2.2001
- File Browser can now copy and delete files
- Print preview will now be shown even for very big or small images
- Saving Video images on harddrive did not work
- Video and Batch: now you can set save parameters
- Images and catalogs can be send via email, email program will be loaded automatically - 
TGA Format added
- Magic Wand effect added
- Attach a picture to another or blend them together 
- Slide Show: Effects added for changing picture
- Morph Filter 
V2.1 14.12.2000
- Shortcuts choosable
- Gamma Correction
- Set number of undo
V2.0 5.12.2000
- Functions for watermarks (small pictures) and secret message in your pictures 
- Viwing and generating pictures with realistic 3D-View with the help of glasses and 
mirrors
V1.25 23.10.2000
- supports more Photoshop Plugins
- has several Weblinks for Plugins in the Internet 
- Webcam now also as a webcam server reachable over the internet.
V1.24-1.0
Picmaster has been released with standard graphics functions, Photoshop Plugins, 
Poster-/Tile-/Nomalprint, Slide Show, Video, Catalogs, etc. 



Other programs

Visit the Homepage of Picmaster. There you´ll find useful Shareware programs.
The address is:

World Wide Web: 

International Homepage:
http://www.graphics-tools.com

German Homepage: 
http://www.grafik-software.de



Contact informationen

Technichal Support is free for registered users. Critics and suggestions are welcome.

E-Mail: Support@Graphics-Tools.com

World Wide Web: 

International Homepage:
http://www.graphics-tools.com

German Homepage: 
http://www.grafik-software.de



How to use help

If you need help to the program, do one of the following steps:

- Press F1, if you need help. If there is any help information    to this situation, it will be shown in 
a new window.

- Load in menu Help      Help topics. There you can load the help topics, search for a specific word
in the index list or in the whole help file.

- If the dialog has a help button, press it and you´ll get to the help page.



Opening and saving images

Open an image:
To open an image, click in menu File on Open. 

A new Dialog will appear, in which you can see your current directory. 
Change into the directory where your images are located. Then you have to select the desired images and 
press on open. 

Tip: To load more than one image, select the first file with the mouse, press and hold your SHIFT-key 
and select the other files by pressing the cursor-keys (still hold the SHIFT-key). 

Tip: You can select several files with the mouse also seperately, if you hold your CTRL-key the whole 
time.

After the images is loaded it will be shown in a new window. You now can simply try out all the menu 
commands. This is the fastest way to learn, what Picmaster can do.

 
Saving images:
If you made changes on your images you want of course to save those: To do this, press in the menu File 
on Save. 

If you want to save the image under a different Filename or Image type, press in menu File on Save as... . 
A Dialog will appear in which you can enter the name and the wanted image type. 

The Image browser:
With the Image browser you can see a preview of each picutre in a folder that help you more than only the
filename. You can access it under File/Image Browser to load files. An window in Explorer-Style opens. 
At the left you see your folders and at the right the images of the folder in a small preview. If you double 
click on an image it will be loaded.



Print

If you have a printer, you can print your images with Picmaster.

If you want to print an image, open the image and then click in menu File on Print ... .
A Print dialog appears, in which    for example you can decide, how big your image should be printed, 
where it should be, if you want additional information and what kind of printing mode you want. The 
meaning of the printing modes is a followed:

Clipping: This is the normal printing mode. Everything not fitting on the page will be clipped.

Tile: The image will be placed on the page as often as possible. This is useful if you want to make a lot of
copies of the image.

Poster: In the Poster mode you can print the image over sereral pages.

Tip: If you need help to the dialog   Print, klich here with the mouse  .  

After you finished to set up the print dialog you only have to press on Print and your image will be 
printed.



Scan

If you have a scanner, you can scan photos with Picmaster.

To scan a photo, press in menu File on Scan und then on Scan ... .
You scanner software will be started and you can scan your image now.
 
Tip: The scanner software is different for each scanner, look in your scanner manual if you need help.



Import from video

If you have the possibilty to plug a camera to your computer, you can import single images from it. 

To do this, press in menu File on Video. Here you can choose between one of the followings:

Record video: Here you can record videos in avi-format. The buttons are similiar to the ones from a real 
vcr.

Capture pics: Images from the camera ca be caught in “Frames” an saved on your computer with 
automatic numbering.

Webcam: You can upload each grabbed picture into the Internet. You can automaticaly send an email to a
person with the image attached to it or put it onto your homepage as a webcam, which for examples 
uploads images every minute. The images can also be grabbed upon movement so your computer turn 
into an alarm system. You can also turn your computer into a webcam server and he sends real time 
images upon request. . Read here more about it.
 
Tip: If you need help to the dialog   Video, press here with the mouse  .  



Webcam

At Video/Webcam you can choose between two method for your webcam:

1. You donwload the pics via FTP onto your homepage, for example every minute.
Disadvantage: It´s not a real time pic, about one minute old.
Sometimes the image will not be shown fully because it is replaced while loading it.

2. You turn your computer into a webcam server. When someone enters your IP-address in the browser 
they get a real time picture. Your IP-address is a four digit number (e.g. 123.456.78.9) which will be 
assigned to you from your provider when you are online.
Disadvantage: If your provider assigned you always a new IP-address each time you connect the address 
is dynamic and can not be integrated into your webcam homepage that easy.
All access goes directly to your computer so you need a fast connection. This method should be used for 
computers always connected to the internet.

Webcam Server 

All current IP-addresses of your computer will be listed at the Webcam Server dialog tab.
Network card for example also have an IP-address so you have to choose the correct IP which is 
responsible for the internet connection. If you connect with a modem your IP will only show up if you are
connected. Use Update to get the IP´s again.

As soon as you hit on GO! Your webcam server will be active. If now someone enters your IP-address in 
his browser    he get´s the image. For example http://123.456.78.9      .You can try it by your own browser. 
At Active Conncetions you can see how many people access your right now. If you use a different port 
than 80 you have to specify it, e.g.: http://123.456.78.9:8080          .

Tip: The IP-Adresse 127.0.0.1 is only for your own computer. With it you can test it while beeing offline.

Tip: If the image is not be shown in the browser hit the reload button to be sure that the browser really 
tries to reload it.

Webcam Homepage

 Now you only need to create a homepage where your webcam image will be shown automatically. To do 
so there are two example HTML-files in the Picmaster Subfolder \Webcam. Some small changes need to 
be done to fit them for your needs. Read the help file also included in the subfolder.

Tip: If you need help to the dialog   Video, press here with the mouse  .  



Slideshow

You can let play your images in a selected order on the screen. 
To do this press in menu Extras on Slideshow and then Slideshow ... . A Dialog appears in which you can 
choose the files change some options for the playing of the show.
There are two ways to choose the files:
You can add the files to a list. To do this, set the option Images from to File list.
You can let play all files in a specific directory. This is useful if there will be always new files in the 
directory and you don´t always want to add them to the list. To do this, set the option Images from on 
Directory.

Tip: If you need help to the dialog   Slideshow,   Press here with the mouse.  



Processing images

There are several ways to process images:

- In the menu Edit you can cut an paste pieces of the images. 
Click here for more informations.

- In the menu Colors you can process the colors (e.g. convert to grayscale, reduce blue color in image, 
sharpen image, convert to negativ, etc.). 
Click here for more informations.

- In the menu Image you can for example change the size, rotate the image, flip it or merge it with 
another image,etc.. 
Click here for more informations.

- In the menu View/Mousepointer you can change the mousepointer into a drawing tool for drawing on 
the image. 
Click here for more informations.

 



 3D-Images

 With Picmaster you can create and view real 3D-Pictures. Picmaster offers a range of different 
methods to view them. Methods range from Red-Green Glasses, mirrors and even to shutter glasses.

 At Extras/3D-Imager you can create the 3D-Images or split them into two seperate pictures.
 Picmaster show you Internet addresses where you can find thousands of created 3D-Images    for 

watching. An with the ability of backconverting the 3D-Images you can even turn them into your 
desired 3D-Method for viewing.

 How do 3D-Images work?

 The two eyes of a human see two slightly different pictures from which the brain calculates the 3D-
Information.

 Hold a pen in front of your eyes and close one eye at a time. You will notice that the pen – looking 
through your left eye – is being places more right and - looking through your right eye - being placed 
more left. From this distance of the pen between left and right eye the brain calculates the deepness of
the pen. If you hold the pen more away from yourself you will notice that the pen position difference 
between left and right eye will be less.

 If you look on your monitor or on a printed image, both eyes will see the same image. So have to 
accomplish somehow that – even when both eyes look at the monitor – your left eye will see a 
different picture than your right eye to create the illusion of a real three dimensional picture.

 To accomplish this, there are several different methods.

 Methods to view 3D-Images
 
 Red-Green / Red-Blue Glasses to view Anaglyph Pictures
 In order that your eyes will see different pictures, color filters will be placed in front of the eyes. The 

Red-Blau Glasses for example is using red for the left eye and blue for the right eye. So your left eye 
will only see the red channel of the picture and the right eye only the blue channel.

 The two images for your eyes from which you will produce the 3D-Image will be packed accordingly.
The 3D-Image has the left picture in the red channel and the right picture in the blue channel.

  
 To view pictures with this method you need Red-Green or Red-Blue glasses.
 Click here if you want to know how to get Red-Green Glasses or Red-Blue Glasses.

 Monotone Image
 These pictures are also anaglyps with the difference that the two images for your eyes has been 

converted to grayscale before doing the calculation. This can be advantage if the own colors of the 
image disturb the 3D-View.

  
 Parallel-View
 This method doesn´t need any additional devices but you need a little practice. The two pictures for 

left and right eye will be placed side by side. You now look at the picture but your eyes have to focus 
a spot behind the picture, as if you would look at a spot behind your monitor. This way the eyes will    
be places parallel and you will only see one resulting picture.

 The width of the 3D-Image should be bigger than double the distance between your two eyes (12 cm).
If this should be the case resize the image to a smaller size before viewing.

 The images also can be viewd with so called “Prism” Glasses.
  
 Crossed view



 Like the parallel view but this time you have to cross your eyes to see the resulting picture. The right 
eye sees the left picture and the left eye the right picture.

 The width of the 3D-Image should be bigger than double the distance between your two eyes (12 cm).
If this should be the case resize the image to a smaller size before viewing.

 Mirror
 Take a mirror and put the border at the black line in the middle of the picture so that the mirror is 

orthogonal to the monitor. The mirror side is on the left. 
 If you now put the head to the outstanding border of the mirror, the mirror is like a divider, your right 

eye sees the right image and your left eye sees your left image. But the two pictures are not at the 
same position yet. This is done by the mirror. It mirros the left image to the right size exactly to the 
same spot where your right eye sees the picture.

 Shutter Glasses
 For this method you need shutter glasses that can show each odd row of the picture in one eye and 

each even row in the other eye on the monitor. Do not zoom the 3D-Image when watching, otherwise 
the rows of the image will not change correctly.

 How do I create my own 3D-Images?

 You can create your own images already with a simple photo camera. All you need to do is make two 
snapshots just like your eyes see the scene.

 So take a snapshot for your left eye and then move the camera about 6 cm to the right (do not change 
direction of the camera) and then take the snapshot for the right eye.

 The distance must be kept exactly, the height of the picture should stay the same and do not jiggle the 
picture. Best to do is work with marks, use a tripod or slide the camera on a horizontal area.

 In order that the image will come out of the monitor, remember the place of a certain spot in the 
picture of your left eye. For the right eye picture turn your camera horizontaly this way that the spot 
has the same place again. The point will be exaktly in the monitor plane (because his distance 
between left and right eye is zero). All points in front of it will come out of the monitor and all points 
behind will go in.

 Of course this method will not work for moving objects. For moving objects there are special 3D-
Cameras. They simlpy consist of two cameras side by side being shot at the same time.

 



 Red-Green / Red-Blue Glasses

 To watch the anaglyph pictures you need Red-Blue Glasses (recommended) or Red-Green Glasses. 
You should get them at an optician sometimes even for free.

 With Picmaster you can make your own glasses by yourself, but be aware that the effect will not be as
good as with bought glasses.

  
 If you click on „Print Red-Blue Glasses ...“ or „Print Red-Green Glasses ...“ ,Picmaster will load an 

image showing the glasses.
  
 You can now:

 Print the glasses on paper, cut them out, cut holes for the eyes and replace them with transparancy foil
of the desired color.

  
 or

 Print the glasses on transparency foil of your printer.
  
 When printing on transparency foil the effect will not be as good. The color is too weak on the foil. 

You can print again on the same foil to increade the color. You can also experiment with the lightness 
of the glasses color by filling the flasses with different colors.



Working with catalogs

With catalogs you can group your images. A contalog consists of small previews of the original images 
which can be loaded quickly. With the catalogs you get a good view over your files. 

Creating a new catalog:
To create a new catalog click in menu File on New and then on Catalog.

Add files to the catalog:
The next step is to add files to the catalog..If you just created a new catalog this dialog will appear 
automtically. Otherwise you have to click in menu catalog on Add file. There you choose your desired 
files and then press open. A small preview of the file will appear in the catalog. 

Tip: If you double click on a preview the original image will be loaded. 

Tip: If you want more informations about catalogs click here with the mouse.

Opening and saving catalogs:
Opening and saving images works the same way as for Images, use the menu File for it..

Tip: If you need help about opening and saving images click here with the mouse.



Working with sound comments

If you have a microphone and a soundcard you can record sound comments to the images. Those you can 
then let play after loading the images or in the slideshow. After you have loaded the image you can 
record, delete or play the sound comment in the menu Image and then comment.

Tip: If you need help to the menu options in   Image->comment, click here with the mouse  .  



Filter

In menu Image/Filter you can choose a range of filters for using on the pictures. You have different 
methods to choose a filter. After you have loaded an image you can use a filter

- By clicking on Filter Browser you can see all filters
- By clicking on Quick-Browser all filters will be used on the image and shown in a preview window
- By choosing it directly at Image/Filter
- By creating an own filter at Image/Filter/User Filter.

User Filter
To create a user filter click on Image/Filter/User Filter.
All pixel of the image will be walked through and the neighbour pixel will be added to it.
The filter has 5 x 5 elements. The elements at the border will be added to the center pixel with a specific 
weight. The higher this value the more they play a role. Negative weights will substract. The result will be
divided by the divider value. Best to do is to first set the weights and then adjust the brightness with the 
divider.

Tip: If you need help to the dialog   Filter, click here with the mouse  .  



Batch - processes

If you always do the same operations on images, batch-processes will help you with your work. You 
simply record your steps and then can use it on the current picture. You can also use it on a whole 
directory or always scan the images 

Record    a process:
To record a process, click in menu Extras on Batch and then on New Record. All following steps will now
be recorded. If you record should be finished click in menu Extras on Batch and then on Stop record. 
Now you have to enter a name for the record and the record is saved.
 
Play process:
Click in menu Extras on Batch and then on Batch... . There you can choose the record to be played. 
In the load picture before-box you can load picutures to use the batch on. You can choose if the pictures 
should come from a catalog, a folder, scanner or all opened.
In the when done-box you can decide what should happen after the batch. The images can be closed and 
saved and the filename can even be nummerated automatically.

Tip: If in the menu View Batch-Window is activated you have a small help window where you can 
comfortably record and play batch files

Tip: If you need help to the dialog   Batch then click here with the mouse  .  



Selection

To select a piece of the image, load the image and then click in the menu View on Mousepointer and then 
for example on Region select. Now press the mousebutton on your image. Hold the button and move the 
mouse to the lower right. A rectangle will appear. When you stop pressing the mousebutton the region 
will be selected. 

A lot of operations now will only be used on the selected area.

To cut, copy or paste a selection, check out the menu edit.

Tip: If you need help to the menu   Edit,   click here with the mouse.  

If you click in the menu View on Mousepointer and then on Polygon select you can define a polygon 
which selects the area. Simply navigate your lines back to the starting point to close the polygon.
 
If you click in menu View on Mousepointer and then on Circle select you can define a cicle which selects 
the area. 



The menu File

The menu File is used for Input and Output of images. They can come for example from your harddisk of 
your scanner. The output could be a for example a slideshow or a printer.

You´ll now see the menu items with a small description about its function. If the menu item is green and 
underlined you can get more information about if you click on it with your mouse.

The menu File has the following menu items:

New->Image    Create a new image.
New->Catalog Create a new catalog.
Image Browser    With the image browser you can see previews of the pictures in your folders.
Reload    Here you can quickly load an old image.
Open ... Here you can open an image.
Save With this you can save your image.
Save as ... With this you save your image under a specific filename.
Save all With this you can save images at once.
Close With this you close your image.
Close all With this you close all images at once.
Print ... With this you can print your images.
Scanner->Scan...     With this you scan your pictures.
Scan->Choose scanner...    With this you choose your scanner.
Video With this you can record videos, import images from a video camera, send them with email or
make a webcam
Send->As email ... Opens your standard email program with a new mail and the picture attached to 
it.
Options... Calls a dialog in which you can change options to Picmaster.
Registration ... With this you can register Picmaster.
Close    With this you can close Picmaster.



The menu Edit

In the menu Edit you can cut an paste a selection of the image. 

Tip: If you need help to selecting images click here with the mouse.

You´ll now see the menu items with a small description about its function. If the menu item is green and 
underlined you can get more information about if you click on it with your mouse.

The menu Edit has the following menu items:

Undo    Undos the last operation.
Cut    With this you can cut the selected area.
Crop  The image consists after the operation only of the selected area. 
Copy  With this you can copy the selected area to the clipboard.
Paste With this you can replace the image with the content of the clipboard.
Choose all(no selection) With this you select the whole image.



The menu Colors

In the menu Colors you can process the colors (e.g. convert to grayscale, reduce blue color in image, 
sharpen image, convert to negativ, etc.).

You´ll now see the menu items with a small description about its function. If the menu item is green and 
underlined you can get more information about if you click on it with your mouse.

The menu Colors has the following menu items:

Reduce Colors    With this you can reduce the number of colors to X.
Color Channels    Here you can seperate the colors into channels and recombine them.
Gamma Correction Here you can change the gamme value of the image. The gamma value can get 
adulterated when scanning or showing the image on the monitor, the color will be too dark for 
example.
Brightness/Contrast Changes Brightness and Contrast of image
Hue/Saturation Changes Hue and Saturation of image
Invert Inverts the image.
Histogram Shows a Histogram of the image.



The menu Image

In the menu Image you can for example change the size, rotate the image, flip it or merge it with another 
image,etc..

You´ll now see the menu items with a small description about its function. If the menu item is green and 
underlined you can get more information about if you click on it with your mouse.

The menu Image has the following menu items:

Change size    With this you can change the width and the height of the image with optional scaling.
Rotate/Flip With this you can rotate amd flip the imag.
Div->Duplicate With this you can create a copy of your current image.
Clear with background color Clears the whole image with the background color.
Attach to another image With this you can attach an image to another one or blend them together. 
This function is useful when scanning images that are bigger than your scanner so you can put them
together afterwards.
Use as Background for windows Uses the image as your background picture for windows. It can be 
shown centered, tiles (side by side drawn on the screen) or as full picture.
Use as Background for windows Uses the image as your background picture for windows. It´ll be 
shown tiled, as often as possible on the screen.
Comment->Record comment With this you can record a comment to the image.
Comment ->Delete comment With this you can delete a comment to the image.
Comment ->Play comment With this you can play the comment.
Comment ->Import comment ... With this you can import the comment from a WAV-file.
Record settings Calls the Setup from Windows for setting the recording options.
Comment ->Set text comment ... Here you can set a text comment which can be shown in the slide 
show.
Filter Here you can use different filters on your image.
Filter->Filter Browser Open a dialog in which you can select the filter. 
Filter->Quick Browser The current picture will be used on every filter and presented in a preview 
window. 
Filter->User Filter Here you can create your own filter. 



The menu Extras

In the menu Extras you can for example change the size, rotate the image, flip it or merge it with another 
image,etc..

You´ll now see the menu items with a small description about its function. If the menu item is green and 
underlined you can get more information about if you click on it with your mouse.

The menu Extras has the following menu items:

Slideshow->Slideshow ...    With this you can create a slideshow of your images.
Slideshow->Slideshow direct from catalog    If your current window is a catalog you can create with 
this function a slideshow with the files of the catalog.
3D-Images -> Eye left/ right -> 3D-Image... Here you convert pictures into a 3D view.
3D-Images ->3D-Image -> Eye left/ right... Hier you convert 3D-Images into seperate Images.
Batch->Batch ... With this you can run batch-processes.
Batch->New record With this you can record a new process.
Batch->Stop recordWith this you stop your recording.
Batch->Pause Record  With this you can pause your record. 



The menu View

In the menu View you can change settings to the view of Picmaster.

You´ll now see the menu items with a small description about its function. If the menu item is green and 
underlined you can get more information about if you click on it with your mouse.

The menu View has the following menu items:

Standard bar Toggles showing of the standard bar with which you can do operations quicker.
Draw bar Toggles showing of the draw bar which which you can do operations quicker.
Images->Ruler    Toggles the showing of a ruler for the images.
Images->Status bar Toggles the showing of the status bar. It shows informations like the dimensions 
of the image or the position of the mouse.
Batch Windows Shows a batch window where you can see a list of your last operations and you can 
save and play them
Mousepointer->Zoom Changes the mousepointer into the Zoom mode. With the left mouse button 
you zoom in, with the right mouse button you zoom out.
Mousepointer->Hand Changes the mousepointer into the hand mode. If the image doesn´t fit the 
window you can scroll it now.
Mousepointer->Select(Rectangle) Changes the mousepointer into the selection mode. You can now 
define a rectangle which selects the area.
Mousepointer-> Select(Polygon) Changes the mousepointer into the selection mode. You can now 
define a polygon which selects the area.
Mousepointer-> Select(Ellipse) Changes the mousepointer into the selection mode. You can now 
define a circle which selects the area.
Mousepointer->Draw Changes the mousepointer into the drawing mode. The mousepointer now has 
the function defined in the menu Draw.
Zoom-> X % Zooms the image to X %. 100 % is normal, below makes it smaller, above makes it 
bigger. The image will not be changed, only the view.
Zoom->Window size Zooms the image that it fits exactly into it´s window.
Zoom->Set With this you can set the zoom value.
Line->Line style With this you can set the line style. Striped lines only work with line width 1..
Line->Line width With this you can set the line width.
Line->Paint color With this you can set the paint color.
Fill->Fill color With this you can set the fill color.
Fill->Fill style With this you can set the fill style.
Pen With this your mousepointer changes to a pen. If you now click on your image, you´ll draw on it
with the current pen style.
Line. With this your mousepointer changes to a line-tool. If you now click on the image and hold the
button you can now set the direction of the line if you move the mouse.
Rectangle/Sqaure With this your mousepointer changes into a Rectangle/Square-tool. If you now 
click on the image and hold the button you can set the rectangle by moving the mouse. To draw a 
square, simply use the right mouse button. 
Ellipse/Circle With this your mousepointer changes into an Ellipse/Circle-tool. If you now click on 
the image and hold the button you can define the ellipse by moving the mouse. To draw a circle, 
simply use the right mouse button. 
Round Rectangle With this your mousepointer changes into an Rectangle-tool with round edges. If 
you now click on the image and hold the button you can define the rectangle by moving the mouse. 
To draw a square, simply use the right mouse button.



Flood fill With this your mousepointer changes into an flood fill-tool. If you now click on the image 
some portions of the image will be filled with the paint color. Filled will be all those colors which are
beside the one you clicked on and have the same color.
Text With this your mousepointer changes into an flood fill-tool. If you now click on the image the 
text set in menu Draw->Set text ... will be drawn.
Get color If you now click on the image with the mouse your paint color will change into the color 
you clicked on. To change the fill color, use the right mouse button.
Remove red eye With this your mousepointer changes into an pen. If you now click on the image, the
red-values will be removed with the current pen style.
Paint with copy of image If you choose a copy point by pressing the right mouse button you can draw
with the left mousebutton. Instead of drawing with the paint color, you now draw with the image at 
the copy point. This way you can repaint object in your image at other places very easy.
Zoom Here you can set the zoom size for displaying the image.



The menu Catalog

In the menu catalog you can manage images. With catalogs you can group your images. A contalog 
consists of small previews of the original images which can be loaded quickly. With the catalogs you get a
good view over your files. 

In Order to use the menu catalog you first have to create a new catalog or load a catalog.

Tip: If you need help with creating and loading catalogs, click here with the mouse.

You´ll now see the menu items with a small description about its function. If the menu item is green and 
underlined you can get more information about if you click on it with your mouse.

The menu Catalog has the following menu items:

Add file With this you can add an image to the catalog.
Remove file Removes the selected images from the catalog. The original images will not be deleted.
View Here you can choose between different view styles for the pictures.
Slideshow from catalog Calls the slideshow dialog with the images from the catalog.
1.Sort Select the sort criteria.
2.Sort Select the second sort criteria.
Thumbnail-print Here you can print the preview images.



The menu window

In the menu Window you can manage your windows.

You´ll now see the menu items with a small description about its function. If the menu item is green and 
underlined you can get more information about if you click on it with your mouse.

The menu Window has the following menu items:

Fit to image size With this you can fit your window to the image size.
Tile horizontal The windows will be ordered (tiled horizontal).
Tile vertical    The windows will be ordered (tiled vertical).
Cascade The windows will be ordered (Cascade).



The help menu

The menu Help gives you help to the program.

You´ll now see the menu items with a small description about its function. If the menu item is green and 
underlined you can get more information about if you click on it with your mouse.

The menu Help has the following menu items:

Help topics Shows you the help topics.
How to use help Describes how to use help.
Welcome Shows a welcome window
Register ... Here you can register.
Other programs Here you can get other programs.
About the program Gives informations about the program.
Reccomend via email Opens up your mail program where you can recommend Picmaster to friends. 



New Image

You´ll now see the descriptions to the components of the dialog.

Pixel: Pixel are the points of the image.
Width: The width of the image.
Height: The height of the image.
Resolution: Defines the Resolution of the image. This is neccessary if you work with cm or inch instead 
of pixel. You have to define how many pixels one cm or inch are. The best thing to do is to use your 
printer resolution. If you don´t know your printer resolution you can simply check it in the menu File and 
then Print ... and then look at Prionter options.
Special: Here you can take predefiened values
Fill color: Here you can set the background color of the    image.
Proportional: If this is activated, width and height only have values that the image is still proportional. 
So if e.g. the width is change, the height will be adjusted automaticaly so the image won´t be distorted.



Print

You´ll now see the descriptions to the components of the dialog.

Preview box: Shows a preview if you press the preview button or the lock is down.
Lock: Show preview permanently.
Preview: Show preview.
Grafik

Left margin: Sets the distance from the left side. In tile mode it will be uses for each image.
Top margin: Sets the distance from the top side. In tile mode it will be uses for each image.
Width: The width of the image.
Height: The height of the image.
Pixel: Pixel are the points of the image.
Proportional: If this is checked, width and height only get values proportional to the original 
image. So if you for exampel change the width, the height will be changed, too, so the image will 
still look proportional.
Move up: Places the image to the top.
Arrows: Places the image at the right position.
Full (Fit): Changes size of image so that it fits exactly into the page.
Full (Cut): Changes size of image so that it fills the page completely. Some Border could get lost.
Original size: Sets the size of the image to the original value.
Double: Doubles the width and height of the image..
Half: Halves the width and height of the image.

Info
Additional Information: Enter here additional Information to be printed with the image.
Cutlines: Prints cutlines to the image so you can cut it better out.
Font size: Set here the size of your font to be used for printed text.

Printer options
Printer: Shows your current printer.
Resolution: Shows your choosen resolution.
Width: Shows the width of the printable area (Page width minus not printable area).
Height: Shows the height of the printable area (Page height minus not printable area).
Page border: Show you how the size of the border, that means the not printable area.
Printer-Setup: Here you can set your print-options.



Video

You´ll now see the descriptions to the components of the dialog.

Video on: Activates/Deactivates the video playback in the video window.
Video window: Show the actual Video.
Frame: Shows a catched picture.
Video window

Video size: Shows the real video size.
Driver: If you have more than one video device installed on your computer you can choose here 
the right one.
Overlay: In Overlay mode you let your video card show the video. This is faster most of the time.
Source: Here you can set the video source.
Format: Here you can change the real video format.
Display: Here youc an change the display options.

Frame
New Frame: Choose when a new frame should be generated. It will be shown in the bottom 
frame window.

Capture images: Here you can import the frames into Picmaster or save them with automatic numbering.
Webcam: Here you can send the frames into the Internet via FTP or Email.
Webcam Server: Here you can turn your computer into a Webcam-Server so others can access it with 
their browser and get the pictures.. Click here to read more.
Status: Here you can check if the sending of the frames has been successful.
Record: Here you can record the video as an AVI-File.



Filter

You´ll now see the descriptions to the components of the dialog.

Preview Quality: Set the quality of the preview.
Before: Shows the original image as a preview.
After: Shows the filtered image..
Preview: To show the filtered image.
Automatic preview: Always preview
Check: Checks the filter at the original image.
Automatic check: Always preview
Quick choose: Generates Preview pics with the actual filters.
Suggestions: : Generates Suggestions with the actual filters.
Default values: Sets the filter to the default values. 

The parameters for the filters are different for each. 



Slideshow

You´ll now see the descriptions to the components of the dialog.

Images from:
Catalog: You can add the images for the slideshow to a catalog. If you click on this options, the 
left side will have the following components:

Add: With this you can add files to the list.
Delete: With this you can remove the current selected files from the list.
Load catalog: With this you can load a previously saved list.
Save catalog: With this you can save the current list.
Sort: Here you can set how the list should be sorted.. 

Directory: You can set a directory in which the images are located. This is useful if you always 
get new images in the directory. If you click on this options, the left side will have the following 
components:

Directory: Here you can set the directory in which the images are located.
Include subdirectories: This will use the subdirectories.
Show following types: Here you can choose the graphic types to show.
Sort: Here you can set how the list should be sorted..

View:
Background color: Here you can choose the background color.
Filter: Here you can set a filter so that zoomed images will look better.
No borders: Hides the border of the window.
Hide mouse: With this the mousepointer will be hidden for the slideshow if it is on the canvas.
Next Pic after x seconds: Here you can set after how many seconds the next image will be 
shown. You can stop this by pressing the “S”-Key at any time.
Repeat when finished: Repeats the slideshow if it is finished.

Size:
Canvas size: Here you can set the size of the area in which the images will be shown. You can 
either set it to full screen, always take the size of the loaded image or seit it by yourself.
Image size: Here you can set the size of the images. You can either use the original size, fit it on 
the canvas (so that there will be black stripes if it doesn´t fit very well) or fill the canvas with the 
image (so that a bit of the edges might be cut of).
Anchor: Here you can set the anchor of the image.

Info:
Sound: You can play a background sound. You can use WAV- and Midi-Files or the recorded 
comments. 
Additional Information: Here you can choose what Information should be shown with the 
image.



Batch

If you always do the same operations on images, batch-processes will help you with your work. You 
simply record your steps and then can use it on the current picture. You can also use it on a whole 
directory or always scan the images 

You´ll now see the descriptions to the components of the dialog.

New Record: Here you can start a new record.
Löschen: Deletes the selected record.
When done:

Nothing: does nothing
Save and close: calls the save dialog when done and then closes the image.
In Directory: The image will be saved and closed when done in the specified directory. The 
graphic format and parameter can either be set or be kept. The filename consists of the text set in 
Startfile and a number, e.g. noname14.jpg. If this file should exist you can decide what should 
happen, should it be overwritten or should the number be incremented.

Load pictures before:
You can load pictures to use the batch on. Sets where the images should come from.

Catalog: You can add the images for the slideshow to a catalog. If you click on this options, the 
left side will have the following components:

Add: With this you can add files to the list.
Delete: With this you can remove the current selected files from the list.
Load catalog: With this you can load a previously saved list.
Save catalog: With this you can save the current list.
Sort: Here you can set how the list should be sorted.. 

Directory: You can set a directory in which the images are located. This is useful if you always 
get new images in the directory. If you click on this options, the left side will have the following 
components:

Directory: Here you can set the directory in which the images are located.
Include subdirectories: This will use the subdirectories.
Show following types: Here you can choose the graphic types to show.
Sort: Here you can set how the list should be sorted..

All opened: This plays the process on all loaded images.
Scanner: This scans the image and then plays the process on it.



Options

Here you can change options to Picmaster.

You´ll now see the descriptions to the components of the dialog.

General:
Background    image: Here you can set the wallpaper for Picmaster. Leave it empty to disable.
Dialog image: Here you can set the wallpaper for Dialogs. Leave it empty to disable.
Language: If you have other language packs you can change the language of the program here.

Image:
Units in: Set the type of units for the ruler.
Image Resolution in: Set the type of units for the resolution.
Pixel: Pixel are the points of the image.
Fit on window size when loaded: When a new image is loaded, the size of the window fill be set
to the size of the image.
Beim Laden auf Fenstergröße zoomen: When a new image is loaded, the image will be zoomed
so that it fits the window.

File types: Here you can decide which graphic types should be linkes with the Windows-Explorer. If you 
then click in the Windows-Explorer on the file, Picmaster will load it.
Catalog:

Image distance: Here you set the distance between the preview images in the catalog.
Image width: Here you set the width of the images in the catalog.
Image height: Here you set the height of the images in the catalog.
Additional Information: Here you can choose what Information should be shown with the 
image.
Font options: Here you can set the font options.

Cache:
Disk-Cache: The Disk-Cache accelerates the loading of images in the catalog by saving them in 
the cache folder.
Memory-Cache: The Disk-Cache accelerates the loading of images in the catalog by saving them
in the memory.
Max. History entries: Choose the max number of lines to be shown in the history window.
Copy image before Plugin Filter: Makes a memory copy before using Plugins Filters. Otherwise
the image in the background will be flipped and has wrong colors while setting the filter. You can 
disable this options if you run into memory problems,, the image will be flipped back correctly 
after the filter.



Change size (Resize)

With this you can change the width and the height of your image.

You´ll now see the descriptions to the components of the dialog.

Pixel: Pixel are the points of the image.
Width: The width of the image.
Height: The height of the image.
Resolution: Defines the Resolution of the image. This is neccessary if you work with cm or inch instead 
of pixel. You have to define how many pixels one cm or inch are. The best thing to do is to use your 
printer resolution. If you don´t know your printer resolution you can simply check it in the menu File and 
then Print ... and then look at Prionter options.
Special: Here you can take predefiened values
Scale with picture: Scales the picture to the new dimensions (Resample)
Filter: Set a filter that image pixels do not look too big.



Filter Plugins

In the menu Image/Plugin-Filter you can include Photoshop compatible filters. You can find thousands of
them in the Internet. These filters have the file ending .8bf    . 
To include them you can either copy them into the Plugins-Filder of Picmaster of press in menu 
Image/Plugin-Filter on Import Plugin-Filter. 

If the plugins shows up in the category "Could not load", the plugin could not be included into Picmaster.
Mostly this is because of missing files in the windows system folder (C:\Windows\System) the plugin 
needs.

Possible files are:
msvcrt.dll 
msvcrt40.dll 
msvcrt10.dll 
msvcrt20.dll 
plugin.dll

The first two files are the mostly needed. If they are not in the specified folder you can download them 
from the Internet at
http://www.graphics-tools.com/filter/filter.htmland copy them into the folder.




